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 Installation Installation Installation Installation     
The installation of Happy Eyes is easy – just double click the setup.exe file and follow the 
onscreen instructions. But before you start the installation, make sure once more that you 
meet the system requirements.  

 System Requirements System Requirements System Requirements System Requirements     

You do not need an extremely powerful computer in order to install and run Happy Eyes, 
although having more RAM and free disk space certainly will be better than keeping to the 
minimum configuration. Here is the minimum configuration: 

• Windows 2000, XP, 2003, or Vista 

• .NET framework 1.1 or higher 

• 500MHz processor 

• 256 MB RAM 

• 20-30 MB free disk space 

 Installation Installation Installation Installation     

To start the installation of Happy Eyes, double click the setup.exe file. This will start the 
installation procedure. The first screen you will see is the screen for language selection: 

 

Figure 1: Select Setup Language  

The available languages are : English , German, Polish , Czech, Italian, Russian and 
Bulgarian. You will see only the languages which your computer system supports.  After you 
select the language for installation, press OK and the Setup Wizard Welcome Screen will 
appear:  
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Figure 2: Setup Wizard Welcome Screen 

Just press Next to proceed to the following screen – the License Agreement: 

 

Figure 3: The License Agreement Screen 
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Read the agreement, select the radio button that you accept it and click the Next button to 
proceed to the Select Destination Location screen, which is shown in the next screenshot.  

 

Figure 4: Select Destination Location 

By default, Happy Eyes will be installed in the C:\Program Files\Happy Eyes folder. 
Although you can use the Browse button to select a different location for installation, 
generally it is not recommended to do it, unless you have a really serious reason – for 
instance, if Windows is installed on a different drive (not on C:\), then the default location 
will be changed, respectively. But even if the drive letter is changed, the installation directory 
should remain Program Files.  

When you are ready with the selecting the installation location, press the Next button to go 
to the Select Start Menu Folder screen. By default, the installation will create a start menu 
folder for the program, unless you put a tick in the Don’t Select Start Menu Folder checkbox.  
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Figure 5: Select Start Menu Folder  

Press Next to go to the Select Additional Tasks screen, which is shown next. 

 

Figure 6: Select Additional Tasks Screen  
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The Select Additional Tasks Screen allows to select if a desktop icon and/or a Quick Launch 
icon to be created or not.  

When you are ready, press the Next button to go to the Ready to Install screen. Here you see 
a summary of all the data you have entered from the start. Check if everything is OK and 
when ready, press the Install button. If you need to change something, you may want to press 
the Back button to return a couple of steps backwards and to change what is necessary.  

 

Figure 7: Ready to Install Screen 

When you press Install, installation will start. While installation is proceeding, you will see 
the screen shown in the next screenshot.  
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Figure 8: Installation Is in Process  

In the last screen, click the Finish button to exit the installation procedure.  

 

Figure 9: Installation Complete 
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 Uninstalling Happy Eyes Uninstalling Happy Eyes Uninstalling Happy Eyes Uninstalling Happy Eyes     

Uninstalling Happy Eyes is not different from uninstalling most Windows applications. 
There are two ways to start the uninstall procedure: 

• Select Start -> Programs -> Happy Eyes -> Uninstall Happy Eyes (if during 
installation you have chosen not to put a Start Menu folder for Happy Eyes, you will 
not be able to find the Happy Eyes folder now) and follow the instructions of the 
uninstall program.  

• Alternatively, you can select Start -> Settings -> Control Panel -> Add or Remove 
Programs (in the list of programs, select Happy Eyes and press Remove). The uninstall 
procedure will finish in a second.  
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 Creating a New Prima Photo Book Creating a New Prima Photo Book Creating a New Prima Photo Book Creating a New Prima Photo Book     
You can create a new photo book when you start the application as shown in the next 
screenshot, (or later if you choose File -> New Photo Book).  

Tip: Most of the steps in the wizard are not mandatory and you can skip them (except the 
last two – selecting the default layout and adding the pictures), if you don’t want to add a 
particular component (a background, a cover, etc.) to your photo book now. Later, when 
your book is ready, you can always change a component you skipped in the wizard.  

 

Figure 10: Creating a New Book at Startup 

When you choose the first option in the above screenshot, the Create New Photo Book wizard 
starts:  

 

Figure 11: Photo Book Properties 

The first screen in the Create New Photo Book wizard allows choosing photo book properties 
like the size of the photo book. There are several available sizes - 205 x 270 mm, 150 x 130 
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mm, 205 x 205 mm, 305 x 225 mm, and 300 x 300 mm. The first three sizes include 
customizable covers and the ability to write text on the book's cover. The Landscape 305 x 
225 mm format includes a hard cover with a cut ellipse window which serves as a preview of 
the first page of the album. 300 x300mm photo book is with hard cover Linen and is not 
possible to add a text on it. You can also select the default font (size, color etc.) for text labels 
and the photo book cover type. When done, click the Next button to proceed to the second 
page of the wizard.  

 

Figure 12: Select Book Cover  

The second page of the Create New Photo Book wizard is for selecting the book cover. To 
enable the list of cover categories, put a tick in the Use Predefined Photo Book Cover 
checkbox. Browse through the categories of covers. When you click a category (for instance 
General) in the left pane, the covers that belong to this category will be displayed in the right 
pane. Double click on a cover to select it. The currently selected cover will appear in the Book 
Cover Preview on the right.  

When you have made your cover choice, click the Next button to move to the Default Page 
Background screen, which is shown in the next screenshot.  
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Figure 13: Select Default Page Background 

The Default Page Background screen helps in selecting the background image for the album. 
You can select an image or color for the background of the album. Depending of what you 
have selected the displayed choices you can see in the right pane.  

When you have selected an image for the background, you can choose additional options, for 
instance if the background will be identical for both sides of the book or if it will spread 
instead. Also, you can choose the image to be mirrored on both sides of the book or to flip the 
image horizontally.  

If you’d rather have a color for background, choose the Color radio button on the right side. 
This will display a dropdown with a color palette accessible for you to choose the desired 
color.  

When you have finished with the selection of the default page background, press the Next 
button to proceed to the Default Photo Frame screen.  
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Figure 14: Select Default Photo Frame  

This screen allows you to choose the default photo frame. Put a tick in the Use Default Photo 
Frame checkbox, to enable the list of frame categories. Browse through the categories that 
are available in the left pane, and when in the right pane you see the frame of your choice, 
double click to select it. When ready, press the Next button to continue to the Default Page 
Layout Screen, which is shown in the next screenshot.  

Tip: If you do not select a frame, the photos will have a shadow instead.  
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Figure 15: Select Default Page Layout  

The last photo book component that can be chosen is the default page layout. After you put a 
tick in the Use Default Page Layout check box, the list of page layout categories becomes 
active. The first group of categories is for double sided layouts, while the second category is 
for single sided layouts, so you can have differing left and right sides.  

If you prefer even and odd pages to be different, choose a page layout from the second 
category. The available choices are Double Sided Layouts and Single Sided Layouts.  

If you choose Single Sided Layouts, the layouts of left and right pages will be the same. If you 
want to have different left and right pages, from the Page Layout Categories drop-down on 
the right select Double Sided Layouts and make your choice from the available options.   

Tip: When selecting the page layout for the album, check what the layout of the photos you 
plan to put inside is.  You can always change the layout for a particular page later but if 
you, for instance, have mainly landscape photos, then choosing portrait layout for all your 
pages is not the best idea.  

When you are done with selecting the default page layout, click the Next button to proceed to 
the last screen in the wizard.  
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Figure 16: Automatic Photo Placement 

The last screen in the wizard is a dialog box where you add the pictures in the album. Click 
on the Plus button to add new files to your album.  

Tip: Your new book will be ready in an instant, if you already have all the photos for the 
book gathered in one folder and arranged in the sequence you want them to appear in the 
album. If you have the pictures for the book gathered in one folder, press Ctrl+A to select 
them all and add them at once.  

The buttons on the right side of the dialog box provide for arrangement options. After you 
have added the pictures, you can select a picture to rotate or delete, you can also move it 
upwards or downwards as well as to send to the beginning or end of the album.  

If the preview box is too small to display enough detail of your photos, you can click the 
button above the preview box and the photo will be displayed in full size.  

 

When you are done, click the Finish button and your new PRIMA photo book will be created. 
While the book is being created, you will see the following message.  

 

 

Figure 17: The Book is in Process of Creation 

After the book is ready, you will see the following message:   
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Figure 18: Info Message  

When you click the green tick, this will open the newly created photobook, as shown in the 
next screenshot:  

 

Figure 19: The Newly Created Photo Book  
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 Modifying an Existing AlbumModifying an Existing AlbumModifying an Existing AlbumModifying an Existing Album    
After you have created an album, it is likely that at some time you will wish to modify it. To 
do so, you need first to open it. This can be done at startup, when in the screen below you 
choose the second option, (or if Happy Eyes is already open – by selecting File   -> Open 
from the menu bar).  

 

Figure 20: Opening an Existing Photo Book at Startup 

The book you have selected for opening will appear in the Work Area of the Main Screen of 
Happy Eyes.  

 The Main Screen The Main Screen The Main Screen The Main Screen     

Most of the modifications are easily done from the Work Area and the button bars of the 
Main Screen. Therefore, let’s first have a look at the Main Screen of Happy Eyes. The Main 
Screen is shown in the first screenshot on the next page and its parts (the blue numbers) are 
described next. 

1. This is the Work Area and albums are displayed in it. There are many activities that can 
be performed directly on the book in the Work Area, without having to go to the menus or 
the button bars. For instance, instead of using the wizard to create a new album, you can 
do it by dragging and dropping pictures from the File Explorer on the left (5) into the 
Work Area, position them there the way you like. (Just do not place the photos very close 
to the page margin because they can be truncated during production.)   
In the Work Area you can make various changes to your book – you can add background 
or text to the pictures, or change the frames to shadows, or rotate the pictures at an angle 
you like more.   
For instance, in the first screenshot on the next page the photos have no frames but only 
shadows. The frames have been removed on deliberately for these two pages but we can 
easily add a frame when we choose it from the right pane (6) of the Work Area.  

Tip: If you drag the vertical grey lines aside, you will increase the size of the Work Area, as 
shown in the second screenshot on the next page.  

The same screenshot shows two more features of Happy Eyes – that you can rotate pictures 
and text. Additionally, one of the photos has a shadow applied to it, while the other two have 
frames, so you can see how both shadows and frames look like.  
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Figure 21: The Main Screen  

 

Pictures and text can be rotated at any angle you wish. To rotate pictures or text just slightly 
grab the green rotation circle at the top of the placeholder box (the blue arrow points to it in 
figure number 22) and rotate it in the direction you want. Both pictures and text can be 
rotated. (If you wish to rotate them at 90, 180, or 270 degrees, you can do it from the Picture 
Properties dialog box, which opens when you right-click a picture and select Properties from 
the shortcut menu).  
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Figure 22: Empty Photo Holders and Text Boxes Rotate Point 

 

2. This is one of the three button bars. It has buttons for general operations with the active 
book like creating a new book, opening an existing book, saving the active book, undoing 
and redoing changes, opening the photo book properties, opening the photo book 
preview, uploading photo book to the web site, going to Prima photo book web site, 
opening the Happy Eyes help and inserting new pages. 

 

Figure 23: The Top Left Button Bar 

3. The second button bar has buttons for modifying book components like book cover, page 
layout, picture frame, and page background – i.e. the elements that affect the appearance 
of the album. This button bar is described here.  

4. The third button bar, (see below figure 24) located at the bottom (under the Work Area) 
is the navigation button bar. Its buttons allow to move around the book – to go to the first 
page, to the previous page, to the page with the selected number, to the next page, and to 
the last page. There are also buttons for inserting multiple pages, picture holders and 
text. The insertion buttons in this button bar are described here.  

 

Figure 24: The Navigation Button Bar  
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5. File Explorer displays the contents of a drive or a directory on your computer. If there are 
images in the directory you have selected in File Explorer, these images will be shown in 
the pane under it. You can drag the images from there and drop them in the album. The 
images that are already in the book have a small green arrow in the bottom right corner, 
thus telling you that they are already in the album; if you delete a photo from the album, 
the arrow disappears.  

6. In the last component of the Main Screen the gallery of available backgrounds, covers, 
layouts, etc. is displayed. When you click a button from 3, the categories for the 

respective component are shown in 6 and you can select them.  

7.  The Toolbar Page Preview provides a shortcut to each and every page of the photo book. 

 Inserting Pages, Pictures, and TextInserting Pages, Pictures, and TextInserting Pages, Pictures, and TextInserting Pages, Pictures, and Text    

 Inserting Pages Inserting Pages Inserting Pages Inserting Pages     

The Insert Page button inserts a page before the page that is currently open. There are some 
other ways to insert pages in the book – for instance, you can select Edit -> Insert Page, or 
when you are in the Work Area, you can right click and the context menu that appears will 
present you with following options, as shown in the next screenshot.  

 

Figure 25: Right-click Menu  

You can choose where to insert the pages – before or after the current one. Additionally, you 
can also insert multiple pages at once. In this case the following dialog will appear:  
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Figure 26: Insert Multiple Pages Dialog Box  

Tip: You can access this dialog directly, if you select the plus button from the Navigation 
button bar.  

 Inserting PicturesInserting PicturesInserting PicturesInserting Pictures    
To insert a photo, either select Edit -> Insert Picture Holder from the menu bar, or click the 
Insert Photo button (you’ll note that the cursor changes to a photo) and then click on the 
page in the album, on which you want the photo to be inserted. You will see a pink rectangle. 
Move it and position it to your liking. Drag an image from the File Explorer on the left (the 
pane below 5 in the Main Screen screenshot) to the pink rectangle.  

You can also insert (or change) the image in the pink rectangle, if you right-click it and from 
the resulting menu select Properties.  

 

Figure 27: Photo Right Click Menu  

Selecting Properties opens the Picture Box Properties dialog box, as shown next. There you can 
adjust the brightness contrast and saturation of the image, flip horizontal and vertical, rotate it 
or simply choose a new image. You can also improve the quality of a dark picture, apply black 
& white and sepia effect or resize its holder. If you are not happy with the changes, you can 
always use the Undo button and restore the image to its original form.  
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Figure 28: Picture Box Properties 

 Inserting Text Inserting Text Inserting Text Inserting Text     

To insert text to a photo, either select Edit -> Insert Text, or right-click on a photo to open 
the right click menu and click Insert Text, or press the Insert Text button from the button 
bar on the right at the bottom of the screen. In either case, a pink rectangle will appear and if 
you double click it, this will display the text editor dialog box which is shown in the next 
screenshot.  
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Figure 29: The Text Editor Dialog Box  

Type in the text you would like to appear on the photo, format it accordingly and press the 
green tick to save the text.  

There is one more button at the top left button bar – the Upload Photo Book button. When 
you click it (or select Web -> Upload Photo Book from the menu bar), the dialog box shown 
in the screenshot below appears. Enter all necessary data and when ready, click the Start 
Photo Book Upload button to upload the book (for registered users only).  

 

Figure 30: The Upload Photo Book Dialog Box  
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 Modifying the Book Cover, Background, Page Layout, and Page Modifying the Book Cover, Background, Page Layout, and Page Modifying the Book Cover, Background, Page Layout, and Page Modifying the Book Cover, Background, Page Layout, and Page 
FrameFrameFrameFrame    

The button bar on the right of the Main Screen contains four buttons for modifying the book 
cover, the page layout, the page frame and the background of the currently open album, 
respectively.  

 

Figure 31: The Top Right Button Bar 

Click on a button, and the categories for the particular component will be displayed in the 
pane below. Click on a category, to display the contents of the gallery that falls into this 
category into the pane below. When the images for the particular category are displayed in 
the lowest right pane, select an image and drag it onto the currently open album.  

The items in both the category and galleries panes have a context menu with two commands 
– Rename and Delete. Use these commands to delete images, if you do not like them or to 
give them names that you’ll remember easy.  

A change you can make to the appearance of the book is to replace the frame with a shadow 
and vice versa. If while you were creating the book you chose a frame and now you would like 
to change it to a shadow, right click the picture and select Change Frame ….  

 

Figure 32: Changing the Frame 

This will open the screenshot shown on the next page:  



 

Happy Eyes Manual                                                         Page 27 

 

Figure 33: Replacing a Frame With Shadow 

Select Do Not Use a Picture Frame and click OK. This will change the frame to shadow for the 
selected picture. If you do not see the shadow right away, right-click the picture again and 
put a tick in front of the Show Shadow option.  

If you need to change the frame (to shadow or to another frame) for the whole book rather 
than for a single photo or you want to make more radical changes to the components of the 
album, you can always use the Photo Book -> Photo Book Properties command to invoke the 
wizard you got already familiar with in the previous chapter “Creating a New ” and to make 
whatsoever changes you feel are necessary.  

In addition to replacing frames with shadows, it is also possible to adjust the picture holder 
to the picture. You can do this either by right-clicking a picture and selecting Resize Holder 
to Fit Picture, or by opening the Picture Properties box and clicking the Resize Holder 
button, as shown in the next screenshot. In both cases the holder will shrink or expand in 
order to better accommodate the picture.  

The Adjust Proportions and Improve menu options do exactly this – adjust the proportions 
of a picture to fit into the holder and improve (dark) pictures by making detail more visible.  
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Figure 34: Resizing the Picture Holder 

 

There are some advanced photo book modifying features, like creating photo frames, page 
layouts and page covers and they are described next. Select File -> New Photo Frame and 
you’ll see the next screen: 
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Figure 35: Creating a Photo Frame  

Select images for the upper-left frame corner and the frame edge and save them under a 
category of your choice:  

 

Figure 36: Saving a Frame  
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The procedure for saving a custom made page layout and book cover is shorter. If the book is 
currently closed and its cover is visible, then you can select File -> Save Page Cover. You can 
also create the cover you like (an image or text) and then select File -> Save Page Cover. 
Alternatively, if the photo book is open on a page the layout of which you have customized to 
your liking, you can select File -> Save Page as Page Layout and this way you will add it to 
the gallery and will be able to use it in the future.  

 

Figure 37: Saving a Cover  
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Figure 38: Saving Page Layout  

When you have made the changes you wanted, there is only one step left – click Photo Book - 
> Photo Book Preview to enjoy the sight of your photos!  
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 Happy Eyes MenusHappy Eyes MenusHappy Eyes MenusHappy Eyes Menus    
Since most of the functionality of most of the menus of Happy Eyes Prima photo book has 
already been explained in the previous chapter, the menus and the commands in them will 
not be explained here. The purpose of this chapter is to present at a glance all the commands 
that users have at their disposal. So, here are the menus and submenus of Happy Eyes:  

                     

 

        

Figure 39: Happy Eyes Menus 

 

 

Note:  

The functionalities are the same for all formats photo books. The only difference is that you 
can’t apply photo or text on the cover of a Landscape photo book and Luxury Quadrate photo 
book because they have predefined covers. 

 

 


